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Chapter 1
Introduction

This chapter discusses RAID-related Serial ATA background information, and the
RocketRAID 1810A Serial ATA RAID solution.

Contents of this chapter:

1.1  HPT601 Powered XOR Engine
1.2  PCI-X Overview
1.3  RAID Basics
1.4  RocketRAID 1810A
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1.1 HPT601 Powered XOR Engine
Making sure that data is protected – while remaining instantly accessible – requires
faster, smarter solutions. HighPoint offers such a solution with an Optimized XOR tech-
nique with advanced Intelligent Cache Algorithm powered by HighPoint’s HPT601. The
HPT601 uses a sophisticated algorithm to automatically do XOR operations on the
parity drive without needing a large amount of memory on the adapter card.  This
solution provides a significant performance enhancement and it is ideal for RAID
implementations.  This will be the preferred choice of OEMs, ODMs, system integrators
and resellers worldwide for its superior performance and ease of use.

1.2 PCI-X Overview
The 64-bit PCI-X architecture supports transfer rates above 1 gigabyte per second, and
operates at speeds up to 133 MHz.  In addition, it is backward compatible with the
existing standard PCI bus.  The bandwidth provided by PCI-X is ideal for industry
standard servers running enterprise applications.

1.3 RAID Basics
RAID (Redundant Array of Independent Disks) is a method of combining several hard
disks (physical disks) into one logical unit (logical disk).  Such combinations can offer
either fault tolerance or higher data throughput than a single hard disk system.

There are usually a few methods through which hard disks can be combined.  The
different methods refer to different RAID Levels, and different RAID levels represent
different performance levels, security levels and implementation costs.

The most frequently used RAID levels include RAID 0, 1 and 5.  RAID 10 is the combi-
nation of RAID 0 and RAID 1.  The following is a brief table of these popular RAID
types:
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1.4 RocketRAID 1810A
With 4 Serial ATA channels, the RocketRAID 1810A provides advanced RAID function-
ality at an affordable price.  It can support up to four hard disks and utilizes a 64bit,
133MHz PCI-X bridge. The RocketRAID 1810A solution is aimed at enterprise storage,
NAS, workgroup and web severs, video streaming, back up and security systems.

The RocketRAID 1810A’s low profile design makes it an ideal storage solution for 1U
Rack mount servers.

The following are some highlight features:
Supports 64bit, 133MHz PCI-X.

  Backwards compatible with standard PCI slots.
  Supports a maximum of 4 hard disks.
  IDE hard disk compatible when used with RocketHead 100 converters (Optional).
  Supports RAID 0, 1, 5, 10, and JBOD.
  Supports hot-spare for automatic rebuild.
  Bootable disk or disk array support.
  RAID configuration & management software tool (GUI- Graphic User Interface
  version and  CLI- Command Line Interface version) .
  Support system memory larger than 4GB (Bigmen support under Linux , PAE
  support under Microsoft Windows).
  Support Intel EM64T and AMD 64.
  Real-time monitoring of device status and error alarm with popup message box and
  beeping.
  Event log for easy troubleshooting.
  Large LBA supports drive capacity exceeding 300GB.
  Low profile.
  Active and Failed LED’s for system chassis.

SATA RAID Function Utility  for RAID Configuration/Management
The RocketRAID 1810A Serial ATA provides multi level RAID support including
RAID 0, 1, 5, 10, and JBOD, as well as powerful software management functions.  In
addition to the BIOS configuration utility, the RocketRAID 1810A includes graphical
OS-based RAID configuration software. CLI (Command Line Interface) software is
available for Linux Operating Systems.

Thin Cable Is Easy To Configure And Improves Cooling Conditions Inside A
Computer Chassis
The Serial ATA architecture replaces the wide ATA ribbon cable with a thin, flexible cable
that is up to 1 meter in length.  The serial cable is smaller and easier to route inside the



computer chassis.  The small diameter cable can help to improve airflow inside the
computer system chassis, in such a way to reduce the thermal in the computer.

An Ideal SATA RAID Solution
As a high-performance, affordable RAID solution, the RocketRAID 1810A makes sense
for nearly any Server, critical business data storage, gaming, Audio/Video editing, secu-
rity system, and high-end personal storage.

IDE Hard Disk Compatible
RocketRAID 1810A Serial ATA RAID host adapter can support up to four hard disk
drives.  It not only is compatible with Serial ATA hard disks, but also supports all
standard IDE hard disks through RocketHead 100 (RH100, sold separately) internal
converter.  See the picture as shown below:

Note:
IDE hard disks attached to the RocketRAID 1810A via RocketHead 100 converters, must
have their jumpers set to the master position.  Some hard disks, such as WD models, may
require "single master" or "master with no slave present" settings - this may call for the
the jumper to be removed entirely.  Consult the manufacturer's documentation for spe-
cific settings.
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Chapter 2
Adapter Installation

This chapter will describe how to install the RocketRAID 1810A host adapter into a
computer system, and how to properly attach hard drives to the adapter.  Please make
sure to read through this chapter carefully before installing the adapter.

Contents of this chapter:

2.1  Adapter Layout
2.2  Adapter Installation
2.3  Adapter’s Installation Verification
2.4  Driver Installation

If you have any questions about the installation procedure, please contact our Cus-
tomer Support Department.  Please refer to Appendix B: How to contact Customer Sup-
port Department.



2.1 Adapter Layout

LEDs Connection:
The 8 pins of each connector are for use with LED’s.
These LED’s represent SATA channels S-ATA1, S-ATA2, S-ATA3 and S-ATA4,
respectively.  The following diagram describes the connector pin definitions.

a)  CON1:  From D1 to D8 are HDD present signals.

b)  CON2:  From D1 to D8 are HDD active signals.

Adapter Installation
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c)  CON3:  From D1 to D8 are HDD failure signals.

Buzzer:
The buzzer will emit warning alarms if one or more hard disks is not responding.  This
function is dependent upon the RAID Management software (see chapter 4).  The alarm
feature will not function properly unless this software has been installed.
The warning sound will be accompanied by a visual warning message.  Confirming this
message (clicking the OK button), will stop the alarm.

2.2 Adapter Installation
Configure and Install the Drives
To install the Serial ATA drives you will use with your RocketRAID 1810A controller.

Note:
1.  If you are installing more than one drive, your system may not have enough power

connectors for each drive.  If this is the case, you may need to use a power extension
cable that provides additional connectors and power supply.

2.  If you are using ATA hard disks, you may need to use a RocketHead 100 converter.

Install the Controller Card
Follow these steps to install and connect hard disks to the host adapter:
1.  Shut down the computer and unplug the power supply.
2.  Please discharge static electricity from your body by touching a conductor.
3.  Remove the corresponding card bracket from the back of the computer chassis.
4.  Insert the RocketRAID 1810A adapter steadily into a PCI slot or a PCI-X slot on the

motherboard and then settle with a screw.
5.  Connect each Serial ATA hard disk to the RocketRAID 1810A adapter using a Serial

ATA cable.  If IDE hard disks are used, set the jumpers of each IDE hard disk to the
master position (please consult the manufacturer's recommended settings for correct
jumper positions), and then connect the hard disks to the RocketRAID 1810A by
using RocketHead 100 converters (sold separately).

6.  Connect all power supply cables to the hard disks.
7.  Replace the cover of the computer chassis.
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Note:
1. If the adapter or hard disk is not recognized, please refer to the Trouble Shooting

chapter for assistance.

2.3 Adapter’s Installation Verification
After installing the RocketRAID 1810A adapter, and connecting the hard disks as de-
scribed above, turn on the computer.  Please pay close attention to the screen display
while starting your computer.  If the following information appears, this indicates that
the RocketRAID 1810A adapter has been successfully installed and recognized by the
computer.

Next, the RocketRAID 1810A adapter’s BIOS will scan the connected hard disks.  Press
Ctrl+ H to enter BIOS setup, then select View->Device.  Please pay attention to the
screen display (See the following screen shot).  If all connected hard disks are displayed
correctly, this indicates that all the hard disks have been correctly installed and recog-
nized by the computer.
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2.4 Driver Installation
After the RocketRAID 1810A adapter has been installed and recognized by the computer,
the device driver must be installed.

  Windows 2000
Installing the RocketRAID 1810A driver during Windows 2000 installation
1.  Booting from the CD-ROM - when the Windows 2000 Setup blue screen appears,

look towards the bottom of the screen.  Windows will prompt you to press F6 if you
want to install a third part SCSI or RAID driver.  Please press the F6 key at this time.

2.  The setup procedure will continue, and will later instruct you to press the “S” key to
specify additional adapters.  Please press the “S” key at that time.

3.  Then the setup program will prompt you to insert the driver diskette.  Please insert the
driver diskette, and then press ENTER to continue.

4.  The following window will display several driver options.

5.  Please select the RocketRAID 182x/181x SATA Controller for Windows 2000 option,
and press ENTER to continue Windows 2000 setup.
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Installing the RocketRAID 1810A driver for an existing Windows 2000 system
After Windows 2000 has started, the system will automatically find the newly installed
adapter and ask you to install its driver.  Please follow these steps to install the driver:

1.  When the Found New Hardware Wizard window appears, click Next to continue.

2.  In the follow-up window, select Display a list. . . and then click Next to continue.

3. Select SCSI and RAID controllers in the hardware type list, and then click Next to
continue.
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4.  In the following window, click Have Disk... to continue.

5.  Insert the RocketRAID 1810A installation disk into the drive selected, then click
Browse to find the driver under the installation folder (A:\Win_2000). Click OK to
continue.
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6.  Select RocketRAID 182x/181x SATA Controller.  Click Next to continue.

7. Click Next to continue.
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8.  Click Yes to confirm the Digital Signature Not Found window when it appears.

9.  The Windows will find the HighPoint RCM device. Click Finish to continue.

10.  Click Yes to restart the system to make the new settings take effect.
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11.  After rebooting, windows should detect the HighPoint RCM Device, click Yes to
finish the installation.

Installation Verification
After the driver has been installed, and the computer has been restarted:
1.  Right-click the My Computer icon, then select the Properties item from the menu.
2.  In the pop-up window, select the Hardware item, and then click on the
      Device Manager button.

Double click the SCSI and RAID controllers item from this window.  Two items as
shown above should be displayed under the SCSI section-one for the HighPoint RCM
Device, and another for the RocketRAID 182x/181x SATA Controller.  If these items
are not displayed, or there is “?” or “!” mark beside either of the entry, the driver has not
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been properly installed.  Delete these entries and reinstall the driver.

  Windows XP/2003
Installing the RocketRAID 1810A driver during Windows XP/2003 installation
1.  Booting from the CD-ROM - when the Windows XP/2003 Setup blue screen appears,

look towards the bottom of the screen.  Windows will prompt you to press the F6 key
if you want to install a third part SCSI or RAID driver.  Please press the F6 key at this
time.

2.  The setup procedure will continue, and will later instruct you to press the “S” key to
specify additional adapters.  Please press the “S” key at that time.

3.  Then the setup program will prompt you to insert the driver diskette.  Please insert the
driver diskette, and then press ENTER to continue.

4.  The next window will display several driver options.

5.  Please select the RocketRAID 182x/181x SATA Controller for Windows XP/2003
option, and press ENTER to continue the installation of Windows XP/2003.

Installing the RocketRAID 1810A driver for an existing Windows XP/2003
system
After the operating system has booted, Windows XP/2003 will automatically detect the
newly installed adapter, and prompt you to install it’s driver.  Follow these steps to
install the driver.

1.  When the Found New Hardware Wizard window appears, select Install from a list or
specific location (Advanced), and click Next to continue.
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2. Click Don’t search..., then click Next to continue.

3. Select SCSI and RAID controllers, and click Next to continue.
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4.  Insert the RocketRAID 1810A installation disk, then click Have Disk to find the
driver under the installation path (A:\Win_XP). Click OK to continue.

5.  Select RocketRAID 182x/181x SATA Controller, then click Next to continue.
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6.  Click Continue Anyway to continue.

7. Click Finish to continue.

8. Click Yes to restart the computer to make the new settings take effect.
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Installation Verification
After the driver has been installed, and the computer has been restarted:
1. Click the Start button, then right-click My Computer icon. Select Properties item from

the pop-up menu.
2.  In the pop-up window, select the Hardware tab and then click the Device Manager

button.

Double click the SCSI and RAID controllers item.  Make sure the item displayed
above is listed under the SCSI section.  If the device item is not displayed, or there is
“?” or “!” mark near the entry, the driver has not been installed properly.  Delete the
item and reinstall the driver.

  Windows NT4.0
Installing the RocketRAID 1810A driver during Windows NT4.0 installation
1.  Press F6 when the installation program prompts Setup is inspecting your computer’s

hardware configuration.
2.  The setup procedure will continue, and will later instruct you to press the “S” key to

specify additional adapters.  Please press the “S” key at that time.
3.  In the following window, select Other, then press the ENTER key to confirm.
4.  Setup will then prompt you to insert the driver diskette.  Insert the driver diskette, and

press ENTER to continue.
5.  In the following window, select RocketRAID 182x/181x SATA Controller for Win-
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dows NT4.0, then press ENTER.
6.  Press ENTER to confirm the devices to be installed and continue the installation of

Windows NT4.0.

Installing the RocketRAID 1810A driver for an existing Windows NT 4.0
system:
1.  Click Start --> Settings --> Control Panel, and then double-click on the
       SCSI Adapters icon.
2.  A new window should be displayed - click on the Driver tab, then click the Add

button.
3.  In the next window, click the Have Disk... button.  The following window will appear:

4.  Insert the driver diskette, and type in the path of driver location: A :\Win_NT in the
above window, then click OK.

5.  In the following window, select the RocketRAID 182x/181x SATA Controller item,
and then click OK.

6.  Confirm the following system prompts to finish the driver installation.  And then
restart the computer.

Installation Verification
After the driver has been installed and the computer has been restarted:
1.  Click Start->Settings->Control Panel, and then double-click on the SCSI Adapters

icon.

Adapter Installation

2-15



2.  Make sure the RocketRAID 182x/181x SATA Controller entry is displayed as shown
above.  This indicates that the driver has been successfully installed.  If the entry is
not displayed, or any “?” or “!” marks is displayed near the device entries, the driver
has not been correctly installed.  Delete these items, and reinstall the driver.

  Windows 9x/ME
Windows 9x/ME operating systems (Win95, 98, and ME) cannot be installed to hard
disks or disk arrays attached to the RocketRAID 1810A host adapter.  The RocketRAID
1810A can be used to add disk or array support to an existing Win9x/ME system, but
the card's BIOS must be skipped when booting the system (Press the END key to skip
the BIOS when the RocketRAID 1810A starts to Post).

After the operating system has booted, Windows will automatically detect the newly
installed adapter, and prompt you to install its driver.  Follow these steps to install the
driver.
1.   After the Add New Hardware Wizard window appears, press the Next button to

continue.
2.  In the follow-up window, select Display a list. . . and then click Next to continue.
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3.  Select SCSI controllers in the hardware type list, and then click Next to continue.
4.  In the following window, click Have Disk... to continue.
5.  Insert the RocketRAID 1810A installation disk into the drive selected, then click

Browse to find the driver under the installation folder (A:\Win98_ME). Click OK to
continue.

6.  Select RocketRAID 182x/181x SATA Controller.  Click Next to continue.
7.  In the following window, click Next to continue.
8.  Click Finish to continue.
9.  Windows will display a prompt to restart the system.  Click Yes to restart Windows.
10. After rebooting, Windows will automatically find the HighPoint RCM device and

install its drivers.

Installation Verification
After the driver has been installed, and the system has been restarted:
1.  Right-click on the My Computer icon on the desktop, and then select Properties from

the menu.
2.  From the pop-up window, click the Device Manager tab, as shown next page:
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Double click the SCSI controllers entry.  Two items should be displayed - one for the
RocketRAID 182x/181x SATA Controller, and the other for the HPT RCM DEVICE.  If
any of these items is not displayed, or any “?” or “!” mark is displayed near the device
icons, the driver had not been correctly installed.  Delete these items, and reinstall the
driver.
If both items are properly displayed, the driver has been installed correctly.

Note:
If the system is not restarted after driver installation, yellow “!” marks may displayed for
the RocketRAID 1810A entries under Device Manager.  Reboot the system and allow
Windows to refresh these entries.
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Chapter 3
BIOS Configuration Utility

The RocketRAID 1810A includes a built-in BIOS configuration utility.  This utility pro-
vides options to configure and manage hard disks or disk arrays connected to the
RocketRAID 1810A host adapter.  The BIOS configuration utility is especially useful
when arrays must be created before an OS is installed.

Contents of this chapter:

3.1    Enter BIOS Configuration Utility
3.2    Create Disk Array
3.3    Delete Disk Array
3.4    Add/Remove Spare Disk
3.5    Set/Remove Boot Mark
3.6    Set Device Mode
3.7    Rename Array
3.8    View Information
3.9   Rebuild Broken RAID 1, RAID 10, and RAID 5 array



3.1 Enter BIOS Configuration Utility
When the following information appears on screen during boot up, press CTRL+H to
enter BIOS configuration utility.

The main interface of the BIOS configuration utility is shown below:

Selecting the options in the main menu:
     Press up, down, right, left arrow to choose the item
     Press Enter to confirm your selection
     Press ESC to return to the previous menu.  Press ESC at the main menu to exit the
       BIOS configuration utility.
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3.2 Create Disk Array
Follow these steps to create a disk array:
i.   Within the main interface, use the arrow key to highlight the Create menu item and
     press ENTER, or the up and down arrow keys to display a list of available RAID

levels.

ii.  Use the arrow keys to highlight the target array mode that you want to create, and
then press ENTER to confirm the selections, as shown below.

iii.  On the Create menu, use the arrow key to highlight the  Array Name option and
press ENTER. The array name dialogue box will appear, as shown next page:
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iv.  Type a new name in the Input Name section, and press ENTER .

Note:
This feature is purely optional.  If you decide not to name the array, the BIOS will use the
default entry.

v.  On the Create menu, use the arrow key to highlight the Select Devices item and press
ENTER.  The device list will appear, as shown below:

vi. Highlight the target disks that you want to use and press ENTER to select them.  After
all of the disks have been selected, press the ESC key to return to the Create menu.

vii. When creating a RAID 0,5 or 10 array in step 2, a block size must be specified.  The
default block size is 64K-a balanced setting suitable for most applications.

Note:
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On the Create menu, use the arrow key to highlight the Block Size and press ENTER.
Select a block size from the pop-up list.  See the picture as shown below:

If you choose to create a RAID 1 array, the block size will be displayed as N/A.  The
block size option only applies to RAID 0, 5 and 10 arrays.

viii. On the Create menu, use the arrow key to highlight Start Creation, then press
       ENTER.  A warning message will be displayed.  See the picture as shown below:

ix. Pay close attention to the warning message.  Press Y to finish the creation, or press N
to cancel.

Note:
The warning message may vary depending on which type of array is created.
       Creation steps are different depending on the array mode: For RAID 0, RAID 10 and

JBOD arrays, the only available creation option is Create Only, which will delete all
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data on the selected disks.
      For a RAID 1 array, on the Create menu, use the arrow key to highlight Start

Creation and press ENTER.  A new submenu will appear, and display two options:
Create Only and Duplication.  See the picture as shown below:

Create Only. The BIOS will destroy all data on the selected disks, and create a clean
RAID 1 array.
Duplication. The BIOS will copy the data on the source disk (the first selected disk) onto
the target disk (the second selected disk) when creating the RAID 1 array.  When you
select this item, the capacity of the target disk must be equal to or larger than that of the
source disk.

Note:
1.  If choose “Create Only”, will quicken the creation, while choose “Duplication” must

spend time to duplicate HDD from the first HDD to the second HDD.
2.  You is suggested to choose “Duplication” to make sure the data can be match.

      For a RAID 5 array: on the Create menu, use the arrow key to highlight Start
Creation and press ENTER.  An option list will appear, displaying two creation
options:  Zero Build, and No Build.  See the picture as shown next page:
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Zero Build (Full).  This method requires every stripe in the RAID 5 array to be zeroed
out.   Note that, the result of an XOR on a set of zeros is also zero.  Consequently this
method of initialization permits parity to be determined and written to disks during the
regular operation of the array (in response to write operations) using the “read-modify-
write” method.  This method owns fully security, but you will spend more time ( It
depends on total capacity of all RAID member disks).

No Build (Quick).  This method assumes that a RAID 5 array is already in a consistent
state with respect to the parity information contained in it.  This is an initialization
method that is typically employed in scenarios where the data and parity in the disks
comprising an array are in a consistent state.  For instance, all drives may be zeroed out
already by the manufacturer, and are suitable for initialization by the means of no build
(such as new, unused factory hard disks).  This method is unsuitable for use when data
in the disks used for building the array cannot be relied upon to be in a consistent state,
i.e., the parity data is comprised of invalid values.  This method is quicker than "Zero
Build (Full)".  But it owns low security.  We suggest you must run "Very an array" under
the HighPoint RAD management software for OS.  If you choose "No Build (Quick)" and
not runs "Verify an array" under the HighPoint RAID management software for OS, this
RAID 5 array has NONE security.
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3.3  Delete Disk Array
Follow these steps to delete a disk array:
Within the main interface, use the arrow key to highlight the Delete menu item and press
ENTER, or up and down arrow to display a list of available arrays.  See the picture as
shown below:

i.  Highlight the target array and press ENTER.  A warning message will
    appear.  See the picture as shown below:

Pay close attention to the warning message.  Press Y to delete the selected array, or
press N to cancel.  After you have confirmed this selection, all data on the array will
be lost.
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Note:
When you want to delete a RAID 1 array, highlight the target array and press ENTER.
An option list will appear, displaying 3 options. See the picture as shown below:

Delete array and all data on it: The array and all data on it will be deleted.
Delete mirror relationship only: The array relationship will be deleted - the disks will
now be listed as single drives.  The data on each of the disks will be left intact.
Cancel: Cancel the deletion and return to the previous window.

3.4  Add/Remove Spare Disk
A spare disk is available to substitute for any failed disk in a broken array.  RAID 1, RAID
10 and RAID 5 provide different methods to reconstruct a broken array.  If a RAID 1 or
a RAID 10 array is broken, data is reconstructed by simply copying data of the surviving
disks into the spare disk.  If a RAID 5 array is broken, the surviving disks have the parity
information needed to reconstruct the data onto the replacement disk.  You can specify
one or more hard disks to act as spare disks.

Follow these steps to add or delete a spare disk from the spare pool:
i.   Within the main interface, use the arrow key to highlight the Add/Remove Spare menu

and press ENTER, or the up and down arrows to display a list of available singe disks.
See the picture as shown next page:
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ii.  Use the arrow key to highlight the target disk and press ENTER to add it to the spare
pool.  A warning message will appear:

Pay close attention to the warning message.  Press Y to add spare, or press N to cancel.
After you have confirmed this selection, all data on the disk you selected will be lost.

iii. Use the arrow key to highlight the target spare disk and press ENTER to remove it
from the spare pool.
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3.5  Set/Remove Boot Mark
Follow these steps to set a disk or a disk array as a boot device or remove the
boot mark:
Within the main interface, use the arrow key to highlight the Settings menu and press
ENTER, or the up and down arrows to open the Settings menu.  See the picture as
shown below:

i.   On the Settings menu, use the arrow key to highlight the Set Boot Mark option and
press ENTER to display the list of logical devices.  Use the arrow key to highlight the
target logical disk, and press ENTER to set it as the boot device.  See the picture as
shown below:

ii.  On the Settings menu, use the arrow key to highlight the Remove Boot Mark option.
See the picture as shown next page:
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Press ENTER, then the boot mark will be cancelled.

3.6  Set Device Mode
i.   On the Settings menu, use the arrow key to highlight the Device Mode option, as

shown below.

ii.  Press ENTER to display the list of physical devices.
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iii.  Use the arrow key to highlight the target disk and press ENTER, then select the
Device Mode option on the Settings menu.

Note:
The RocketRAID 1810A automatically detects and assigns the correct hard disk mode
setting-we do not recommend changing the default value.

3.7  Rename Array
i.  On the Settings menu, use the arrow key to highlight the Array Name option.

BIOS Configuration Utility

3-12



ii.  Press ENTER to display the list of arrays.

iii.  Use the arrow key to highlight the target array and press ENTER.  Type a new name
for the array in the black textbox, then press ENTER to confirm.
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3.8 View Information
i.   Within the main interface, use the arrow key to highlight the View menu, then press

ENTER or the up and down arrows to open the menu.  This menu displays three
options:  Devices, RAID Array and Logical Device.

ii.  Select an option, then press Enter to display the corresponding information.
             Devices: Displays information about all the physical devices attached to the
                                RocketRAID 1810A adapter.
     RAID Array: Displays information about all arrays.
Logical Device: Displays information about the logical devices, which are visible under
                               the OS.
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3.9 Rebuild Broken RAID 1, RAID 10 and RAID 5 Array
An array is broken when it loses one or more members.  When the BIOS detects a broken
RAID 1, 10 or RAID 5 array, it will do the following:

i.   If one spare disk is available, the BIOS will automatically use it to rebuild the broken
array.  If multiple hard disks are available, the BIOS will automatically select the
closest match to the original disk.  During the process of rebuilding, the following
window will be displayed:

ii.  If no suitable spare disk can be used to rebuild when the BIOS has detected that a
RAID 1, 10 or 5 array is broken, the BIOS will provide several options to solve the
problem.  See the picture as shown below:
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1. Power off
This option enables you to power off the computer and replace the failed disk with a
replacement disk.

Note:
If your computer does not support APM, you must turn off your computer manually.

2. Destroy
This option allows you to delete the broken array.  For broken RAID 1 arrays, the data on
the surviving disk will be preserved after the destroy operation (see section 3.3).  If  you
select this option for broken RAID 10 , RAID 5, JBOD, or RAID 0 array, all data on the
array will be lost.

3. Continue
This option allows you to skip the problem, and boot into the OS.

4. Rebuild
This option allows you to select another single disk attached to the controller to rebuild
the broken array.

i.  After selecting this menu item, a list of single disks will be displayed.  See the image
below:

ii.  Choose the target disk and press ENTER to rebuild the array.

Warning:  All data on the selected disk will be destroyed, then the BIOS will start the
rebuild process.  See the picture as shown next page:
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Note:
If possible, we recommend that you boot the system, and use our RAID Management
software to rebuild the array.  The software can rebuild arrays many times faster than
the BIOS utility.
Please refer to chapter 4 for detailed instructions.
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Chapter 4
HighPoint ATA RAID Software

This chapter describes how to use HighPoint RAID Management (H.R.M.) software  in
detail.

Contents of this chapter:

4.1  Introduction
4.2  Installation
4.3  Get Started
4.4  Use the Software



4.1 Introduction
The HighPoint RAID Management Software is composed of two separate utilities:
HighPoint RAID Management Console and HighPoint RAID Management Service.

To simplify this guide, we will refer to the Management Console and Service Manager,
and the HighPoint RAID Management Service as the Management Service.

Additionally, the system that hosts the Management Console may be referred to as the
administrative system, and the system that hosts the Service Manager may be referred
to as the remote system.

The Management Console can be installed to any computer, and is used to monitor and
control RAID configurations utilized by other computers (remote systems).  From the
Management Console, you can monitor one or more of these remote systems.  The
software can be used to create, monitor, delete, or modify various types of RAID arrays,
including RAID 0, RAID 1, RAID 10, RAID 5 and JBOD.

The Service Manager is designed to run continually on computers that utilize one or
more HighPoint ATA RAID controller.  It is designed to receive and carry out commands
issued by the Management Console: logging events, executing scheduled tasks, and
creating or rebuilding RAID arrays.

4.2 Installation
Follow these steps to install the Serial ATA RAID software under Windows:
1.  Insert the HighPoint Serial ATA RAID Management Software setup floppy diskette

1# into your floppy drive, and double click the setup.exe icon to start the installation
procedure.  When prompted, insert the remaining disks, and follow the instructions
displayed by the setup program.

2.  Confirm the follow-up dialogue windows to finish the installation.
3.  You can install both the Management Console and the Service Manager to a single

computer, or install the Management Console to one computer, and the Service
Manager to another (or several others).  You can access the Service Manager through
the Management Console software.  See the picture as shown next page:

HighPoint RAID Management software

4-1



Click Next  to continue.

Click OK to continue.

Click Finish to complete setup.
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Note:
It is strongly recommended to exit all windows programs before running this setup
program.

4.3 Get Started
With the default option selected, the setup program will create a program group.  Click
Start->Programs->HighPoint RAID Management Software, the following items should
be displayed:

Management Console For the remote systems (or any system using a
HighPoint RAID controller)

Service Manager For the administrative system
Uninstall... Uninstall the program

1. Starting the management service
When you click the Service Manager option, the    icon will appear at the bottom
right-hand corner of the system’s desktop.  Double-click the icon to open the main
interface of the  Service Manager:

The colored traffic lights represent the Service's status.  The (    ) button can be
used to activate or disable the Server Side software.  A green light indicates RAID
service is started.  A red light indicates RAID service is disabled. Check the Service
started automatically option, so that each time the system is launched, the RAID ser-
vice will be started.
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2. Starting the management console
When you click the Management Console option, the  icon will appear at the bottom
right-hand corner of the system’s desktop.  At the same time, the main interface of the
Management Console software appears on the desktop.

The main interface has five menus: File, Management, View, Operation and Help.  Click
on the different menu to activate the different commands.  See the picture as shown
below:

                 File:  This menu includes five submenus: Remote Control,
                              System Configuration, User Management, Password
                            and Exit. Click the Exit button to exit Serial ATA RAID software.
Management: This menu includes six submenus: Array Management, Device
                               Management, Spare Management, Event Notification, Task
                             Schedule Management and Refresh.
                View: This menu includes two submenus: Event View and Icon View.  The

              system will display the connection status of all the attached disks or
                           disk arrays.  The Event View window will display all of the events
                           recorded while the software is running.  The Icon View window
                          explains the functions of the various icons used by the software.
      Operation: This menu includes seven submenus: Create, Delete, Rename, Add
                             Disk, Verify, Rebuild, and Abort.
                Help: Click this menu to view the Help Topics or the version information
                           About this HighPoint RAID Management software.
                          The help feature summarizes the functions of this software, and
                           includes a topic search option.
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4.4 Use the Software
  The File menu

This software allows you to connect to remote computers that utilize HighPoint RAID
controllers over the Internet connection.  After verifying the system’s name and
password, the software can be used to monitor, repair or modify existing RAID arrays
utilized by the remote system.  The software can also be used to modify user information
and the Management Service’s configuration.

1. Remote Control
Click on the File menu, select the Remote Control option and press Enter to open the
Remote Control Window.

a) Add a connection
This option is used to add a new system to the Remote Control window.  Systems added
to the Remote Control window automatically appear each time the program is launched.

Click the Add button on the toolbar in the Remote Control window to add a new system.
See the picture as shown below:

Enter the remote system’s address, name and port information into the appropriate
fields, then click OK.  Make sure the Address and Port information are correct - the
software will be unable to connect to the remote system if any information is left out.

Note:
If you do not need to connect to a remote system, and only need to operate the arrays
attached to the local system, choose to add a new system, and enter the following
information into the appropriate fields:

System Address:        127.0.0.1
System Name:           RAID (must be capitalized)
System Port:              7402
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b) Modify a connection
This option is used to modify the connection information (the name and port).  First,
select one connection from the connection list, and then click the Modify button on the
toolbar, or click on the Operation menu and select the Modify option to open a Modify
Connection window.  See the picture as shown below:

After modifying the system name and system port information, click OK.

Note:
1.  The System Address information is grayed and cannot be modified.  In order to

modify this item, the connection must be deleted and recreated.
2.  Make sure the connection is inactive.  It must be disconnected before it can be

modified.

c) Delete a connection
This option is used to delete a connection.  First, select one connection from the con-
nection list, and then click the Delete button on the toolbar, or click on the Operation
menu and select the Delete option.  A confirmation window will be displayed.  See the
picture as shown below:

Click Yes to delete the selected connection, or No to cancel.

Note:
Make sure the connection is inactive - it must be disconnected before it can be deleted
from the connection list.
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d) Connect to a remote system
Click the Connect button on the tool bar, or click on the Operation menu and select the
Connect option.  You can also double-click the desired connection from the connection
list to start this operation.  A new window will be displayed.  See the picture as shown
below:

Enter the different values in the above fields, and then click OK to display the warning
message, or Cancel to cancel this operation.  See the picture as shown below:

Click OK to change the default password. See the picture as shown below:

Click OK to display the information. See the picture as shown next page:
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Click OK to connect to the selected system.

System Address:  127.0.0.1  (this value can also be changed to the address you
                                want to connect to)
         System Port:  7402

 User Name:  “RAID” (must be capitalized)
 Password:  “hpt” (must be lowercase)

1. You can only connect to one remote system at a time.  Be sure to break the previous
connection before attempting to connect to another system.

e) Disconnecting a remote system
To disconnect a remote system, click the Remote Control command on the File menu,
then click the Disconnect button on the toolbar to display a new window.  See the
picture as shown below:

Click Yes to disconnect the remote system, or No to cancel.

2. Remote System Configuration
Click on the File menu, and select the System Configuration option to display the
following window.

You can modify the values in the System Port and Event Port fields.
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a) System Port
When connecting to the remote system, make sure the port value is correct.  The default
value is 7402 - this may be changed.

b) Event Port
The Management Console software retrieves event information through this port.  The
default value is 7403 - make sure this value is not the same as the system port value.

After setting up the system configuration, you must exit and restart the software to make
the changes take effect.

Note:
1.  If some firewall has been installed to your system, when you connect to a remote

system, the system port may be disabled so that the connection may be failed.  In this
case, please open your system port manually in the firewall.

2.  If the system is only used under the intranet, please check the port 7402 and 7403 to
ensure these ports have been closed by the firewall.

3. User Management
Click on the File menu, and select User Management option to open the following
window.

The User Management window displays information about all valid user accounts, and
provides options to add, delete or modify user information.

a) Add a user
Follow these steps to add a new user:
1) Click the Add button and enter a user name and password.  Confirm this password, and

then the Next .  See the picture as shown next page:
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2) Click the Privilege button, and select the appropriate security privileges.  Click
Finish.  See the picture as shown below:

3) Once a new user has been successfully added, the user’s entry will appear in the User
Management window.
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b) Delete a user
Select a user entry from the User Management window, and click the Delete button.
Then the selected user will be deleted.

Click Yes to delete the selected user.

Note:
Make sure the selected user is not connected to the remote computer - the Delete option
will be disabled if you are connected to the system.

c) Changing a user’s password
Select a user entry from the User Management window, and click the Set Password
button.  You can also click on the File menu, and then select the Password option.  Enter
the new password and click OK to confirm or Cancel to cancel this operation.

d) Change a user’s privilege level
Select a user entry from the User Management window, and click the Privilege button to
display the following window:
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Make appropriate changes and click OK to confirm or Cancel to cancel this operation.

  The Management menu
The HighPoint RAID Management Console software supports a variety of RAID man-
agement features, which are listed on the Management menu.  You can also use these
features by clicking the buttons in the main interface.
1.  Array Management
Click on the Management menu and select the Array Management option.  This will
open a new window, which displays all of the logical drives attached to the RAID
controller.  The logical drives are grouped according to the physical disks.  See the
picture as shown next page:
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Click on a drive icon to display information about this disk - the right side of the screen
will provide information about the physical disk, including the model, type, location,
revision, capacity, status and transfer mode.  Click on an array icon to provide informa-
tion about the selected array, including the name, RAID type or level, and capacity.

a) Create an array
If the Create Array option has been enabled under the Privilege settings, and enough
disks are available to create an array, click the Create button on the toolbar.  You can
also click on the Operation menu, and select the Create option to open the Array
Creation Wizard window.

Step 1: Select the type of array
Select the type of array you wish to create from the drop-down menu.  If JBOD was
selected, you can jump directly to Step 3.

If any other type of array is selected, enter an array name, and click the Next button.  If
you do not wish to name the array, leave the default name in the Array Name field and
click Next.
If RAID 0, 10, or 5 is selected, proceed to step 2.
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If RAID 1 is selected, select from the following array options.  See the picture as shown
below.

1) Create Only
This option will create a RAID 1 array between the selected disks, but the data on both
disks will be lost.

2) Create and Duplicate
This option will create a RAID 1 array between the selected disks, and will copy data
from the source disk to the mirror (also referred to as the target) disk.  All data that was
originally stored on the Mirror disk will be lost.

Step 2: Specify the block size
When creating a RAID 0 or 10 array, select the Block Size from the drop-down menu,
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and click the Next button.  See the picture as shown below:

When creating a RAID 5 array, select the block size from the drop-down menu, and the
appropriate Creation Option.  See the picture as shown below:

1) Zero Build
Create and initialize data blocks with zero build-this will create the array and initialize
parity, but delete all data of each hard disks.  Use this option when starting from scratch.

2) Scrub (build parity)
This will create an array and initialize parity using the existing data on the hard disks.
This method requires the parity of every stripe to be evaluated and written to the appro-
priate location on the RAID array.  A "scrub" may be performed on an un-initialized array
(i.e., an array with un-initialized disks) so that parity can be determined and written to
disks during the regular operation of the array (in response to write operations) using
the  "read-modify-write" method.

HighPoint RAID Management software

4-15



3) No Build
Create only - the parity function will not become active until the array is first used.
When you select this option, you will see a warning message.

Click Yes to continue the creation.

Step 3: Select the array disks
Select the single disks from the Available Disks list, and add them to the Selected Disks
list using the ( ) button.

If you are creating a RAID 1 array, and have selected the Create and duplicate option,
the disk that you select first will be the source disk, and the second will be the mirror
disk.  Please make sure the capacity of the mirror disk is larger than that of the source
disk.
If you are creating a RAID 1 array, and have selected the Create Only option,
the source disk will be automatically selected.
 After selecting the required disks, please click the Finish button to create the
array.

b) Rename an array
Click on the Management menu, and then select the Array Management option .  Select
the array you want to rename from the tree display, and click the Rename button on the
toolbar.  You can also click on the Operation menu, and select the Rename option.  See
the picture as shown next page:
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Enter a new name for the desired array, and then click OK to confirm or Cancel to cancel
this operation.

Note:
You cannot rename arrays that are in the process of being duplicated, initialized, rebuilt
or verified.

c) Delete an array
Click on the Management menu, and then select the Array Management option.  Select
the array you want to delete from the tree display, and click Delete button on the toolbar.
You can also click on the Operation menu, and select the Delete option to display a
warning message.  See the picture as shown below:

Click Yes to delete the selected array, or No to cancel.

Note:
You cannot delete arrays that are bootable or in the process of being duplicated, initial-
ized, rebuilt or verified.

d) Add a disk to an array
Click on the Management menu, and then select the Array Management option.  If an
array is broken, you will have to add a new single disk to proceed rebuild.  Select the
broken array, and then click the Add Disk button on the toolbar.  You can also click on
the Operation menu, and select the Add Disk option.

If this menu option is disabled, then the disks cannot be added to this particular array, or
the Add Disk Privilege has not been enabled.
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When booting the computer, if one member disk of RAID 1, RAID 10 or RAID 5 array is
broken, and there is a spare disk can be used to rebuild the broken array, system will
automatically use the spare disk to rebuild the broken array and then replace data to the
target disk.  See the picture as shown below:

Select the array you want to rebuild, press the OK button to rebuild the broken array, or
press Cancel to cancel this operation.

If you press the OK button, the following window will appear.  See the picture as shown
below:

Click Yes to start the rebuild process.  See the picture as shown next page:
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Note:
1. In the process of  rebuilding, the Management Console will display the remaining time.
2. During the system reboot, the Management Console can save rebuilding progress
automatically instead of rebuilding from the beginning.

When the system detects a physical disk, a dialogue box will appear.  Select a single disk
from the list, and add it to the broken array.  Continue to add disks to the broken array
until the broken status changes.  Once the status changes, the system will begin the
auto-rebuild process.  When the rebuild procedure is complete, please restart the com-
puter.

e) Verify an array
Click on the Management menu, and then select the Array Management option.  Select
the array you want to verify, and click the Verify button.  You can also click on the
Operation menu, and select the verify option.  Once the verify command has been
executed, refresh the software interface - a progress bar should appear.

If this menu option is disabled, then the array cannot be verified, or the Verify Disk
Privilege has not been enabled.

To abort the procedure, click on the Operation menu, and select the Abort option.  This
will cancel the Verify procedure.
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f) Rebuild an array
Click on the Management menu, and then select the Device Management option.  High-
light the array that needs rebuilding, and click the Rebuild Array button.  The broken
RAID 5, RAID 1, or sub-RAID 1 of RAID 10 array can use this feature.

If this menu option is disabled, then the array cannot be rebuilt, or the Rebuild Array
Privilege has not been enabled.

To abort the procedure, click on the Operation menu, and select the Abort option.  This
will cancel the rebuild procedure.

g) Rescan the devices
Click on the Management menu, and then select the Device Management option.
Click the Rescan Device button, or click on the Operation menu, and select the
Rescan Devices option.   This will scan all of the physical devices attached to the
RAID controller.

2. Device Management
Click on the Management menu, and then select the Device Management option.  This
will open a new window, which displays all of the physical drives attached to the RAID
controller.  The physical drives are attached to the individual channel of RAID control-
ler.  See the picture as shown next page:
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Clicking on a drive icon to display information about this disk - the right side of the
screen will provide information about the physical disk, including the model, type, loca-
tion, revision, capacity, status and transfer mode.  If you want to unplug the hard drive,
you can close all the operation on this hard drive, and highlight the hard drive, click the
Unplug button. You can also click on the Operation menu, and select the Unplug option.
Once the unplug command is executed, the physical drive will be off-line.

Clicking on a channel icon to display information of this channel; click the RAID Con-
troller icon to display information of this RAID controller.

3. Spare Management
Click on the Management menu and then select the Spare Management option.  This
will open a new window.  See the picture as shown next page:
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a) Assign a disk to the spare pool
To assign a spare disk to an important array, select the Assign to a dedicated array
option.  Disk arrays that can utilize the spare feature will then be displayed, and listed on
the drop-down menu towards the right side of the array list.  When an array is selected,
the Available Disk  section will list all the single, physical disks attached to the RAID
controller.  The Spare Pool section will list the physical disks that have already been set
to spare disks.

The procedure can be repeated to add or remove additional spare disks.

4. Event Notification
Click on the Management menu and then the Event Notification option to set E-mail
notification so that the system will send an E-mail to the mailbox when an event occurs.

a) Set an E-mail notification
In order to send and receive E-mail, you must first configure the SMTP server.  Click the
Settings button on the toolbar, or click on the Operation menu and select the Settings
option.  The E-mail notification setting window will be displayed.  See the picture as
shown next page:
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Check the Enable E-mail Notification option, and fill the Mail From, SMTP Server, and
Port fields with the appropriate information.  Click OK to complete this process or click
Cancel to cancel this operation.  The system does not support user-validated SMTP
server.

b) Add a recipient
Click the Add button on the toolbar, or click on the Operation menu and select the Add
recipient option.  This will open the Add Recipient window.
See the picture as shown below:

Enter an E-mail address, the recipient’s name, and the notification options.  Three types
of E-mail notification options are available: Information, Warning, and Error.  You can
check them by his requirement and then click OK to confirm the selection.

c) Modify a recipient
Click the Modify button on the toolbar, or click on the Operation menu and select the
Modify Recipient option.  This will open the Modify Recipient window.  Modify the
desired fields, and click OK to confirm.
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d) Delete a recipient
Highlight a recipient, and click the Delete button on the toolbar, or click on the Opera-
tion menu and select the Delete Recipient option.  This will open the Delete Recipient
window.  A warning message will be displayed.  Click OK to delete the recipient.

e) Test to notify
Highlight a recipient, and click the Test button on the toolbar, or click on the Operation
menu and select the Test to notify option.  This will send a testing mail to the recipient.
If you fail to send this mail, you will get a pop-up error message.

5. Task Management
Click on the Management menu, and then select the Task Schedule Management option.
The following window will be displayed:

When an array needs to be regularly verified or rebuilt, you can create a new
scheduled task to automatically manage this procedure.

The Task Schedule list displays information about all added tasks.  Double click one of
the task entries, or select one and click on the Details button to display detailed informa-
tion about the selected task.  If the appropriate Privileges have been enabled, you can
add new tasks, modify or delete the existing tasks.

a) Adding a task schedule
There are two types of tasks that can be scheduled: Verify Array or Rebuild Array.  If
any arrays can be rebuilt in the current system, click the New button on the toolbar to
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open the New Task Schedule Wizard.  See the picture as shown below:

Select the task type, and the target array from the drop-down menu.  Then, click Next to
continue.
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The above window is used to configure the frequency a particular task should be run.
The current time of the connected remote system is displayed on the top.

b) Add a new task:
1.  Enter a name for the task.  You can also use the default task name.
2.  Set frequency.  To add a task to rebuild an array, you can select the Occur one time

option.  To add a task to verify an array, you can specify the detailed occur time by
daily, weekly or monthly.

3.  Set the effective date for a task in the Duration option.
4.  Check the Enable the task option to activate this task.  If this option is unchecked,

then the system will never execute this scheduled task.
5.  Click the Finish button.  When a task has been added successfully, it will appear to

the task schedule list in the main window.

c) Modify a task schedule
Select a task that you want to modify from the Task schedule list in the main window,
and then click the Modify button on the toolbar.  In the pop-up window you can modify
the task name and the frequency the task occurs.

d) Delete a task schedule
Select a task that you want to delete from the Task Schedule list displayed in the main
window, and click the Delete button on the toolbar.

Note:
If an array is deleted, all tasks assigned to the array will be deleted as well.

6. Refresh
Click on the Management menu, and then select the Refresh option.  This command will
rescan all the devices attached on the RAID controller.

  The View menu
1. Event View
Click the View menu, and select the Event View option.  This will display a list of all the
logged events of the remote system.
There are three types of logged events:  Information, Warning, and Error.
1. Selecting one of the Filter options will display all the selected type of events in the

following Event View window.
2. Clicking the Clear button will clear all the events listed in the Event View window and

those stored on the remote system.
3. Clicking the Save button will save all the events listed in the Event View window as a
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plain text file.
4. Clicking the Print button will print all the events listed in the Event View window.

2. Icon View
Click the View menu, and select the Icon View option.  A new window will be displayed
showing the various event icons and their descriptions.

HighPoint RAID Management software

4-27



Chapter 5
Trouble Shooting

Please refer to this chapter if you encounter any problems while using the RocketRAID
1810A.

It provides answers to the most frequently asked questions, and solutions to some of
the more common problems associated with the host adapter.



1. The RocketRAID 1810A host adapter is not recognized by the
system after it has been installed into a PCI slot or a PCI-X slot.
If the card is detected by the system, the following screen will be displayed when the
computer is starting up:

If the above screen does not appear, the adapter is not recognized by the system.
Then, please open the computer’s chassis, and check the following:
1)  Whether or not the adapter has been securely installed into the PCI slot or a PCI-X

slot.
2)  If necessary, try using another PCI slot or a PCI-X slot.

After securing the adapter, replace the computer case and power on the system.
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2. The hard disk connected to the host adapter is not detected.
After the RocketRAID 1810A adapter is recognized by the system, the adapter’s BIOS
will start to scan for hard disk drives.  If drives are detected, the following information
will be displayed:

Please pay close attention to the information displayed by the BIOS - make sure all of the
hard disks attached to the controller are recognized by the BIOS.

If one or more of the hard disks are not recognized, open the computer’s chassis and
check the following:
1) Make sure the power cable for the hard drive is securely attached.  If necessary, try

using another power cable.
2) Make sure the SATA cable is securely attached to the hard disk and the host adapter.

If necessary, try using another SATA cable.
3) If IDE hard disks are attached to the RocketRAID 1810A via RocketHead 100 convert-

ers, make sure the hard disk jumper is set to the Single position.  Check the hard disk
documentation for the manufacturer’s recommended jumper settings - some drives
may have to be set to single or master, or master with no slave present instead of the
conventional master setting.

After checking these items, replace the computer’s chassis and power on the computer.
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3. The operating system will not boot when the boot drive is attached
to the host adapter.
In order to boot from a disk or disk array attached to the RocketRAID 1810A, certain
BIOS settings are required:
1)  Make sure the motherboard’s BIOS setup has set the host adapter as the first boot

device.
If the motherboard’s BIOS setup does not list the host adapter as a boot option, use
the SCSI option.

2)  Set the proper boot disk or disk array using the host adapter’s BIOS (see Chapter 3 for
more information).

4. Win9x/ME operating systems will not boot when a disk drive is
attached to the RocketRAID 1810A.
The RocketRAID 1810A does not allow Win9x/ME operating system to be installed to,
or booted from any disk or array attached to the SATA channels.  If you wish to boot
Win9x/ME from another device attached to the motherboard, make sure to press the
END key to skip the BIOS when the RocketRAID 1810A starts posting during bootup.

5. What should I do if an array is reported as broken?
If an array is reported as broken, shut down the system and make sure the power and S-
ATA cables are securely attached to the hard disks.  If necessary, change the cables,
then power on the system.  If the problem is related to a connection issue, this may
restore the array.

If this method is ineffective, the broken array was likely the result of a failed disk or
hardware malfunction. You need to determine which hard disk has failed in a broken
array.

After that, you should rebuild the broken array.  Refer to the “3.9 Rebuild Broken RAID1,
RAID10 and RAID5 Array” section on page 3-15 for the details.

6. Why does the alarm “buzzer” continuously beep?
The alarm will sound if one or more hard disks is not responding.
To stop this alarm:
1.  Replace the faulty disk with a functional hard disk.
2.  Click on the Management menu, and then select the Device Management option from

the menu.  Click on the Rescan Device button, or click on the Operation menu, and
select the Rescan Devices option to rescan all of the physical devices attached to the
RAID controller.

3.  Reboot the system.
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7. The RAID management software does not seem to recognize the
RocketRAID 1810A installed into my system.  What is causing this
problem?
An account must be created in order for the software to recognize any host adapter.
Choose to add a new account, and use the following values:

System Address: 127.0.0.1
System Port: 7402
System Name: RAID (must be capitalized)
Password: hpt (must be lowercase)
These values must be used if the software and host adapter are installed into the same
system.

8. Why can't I connect to a remote system when using the RAID
management software?
Please check the following:
1.  You have installed HighPoint RAID Management Service on the remote system.
2.  The HighPoint RAID Management Service on the remote system is started. On the

remote system, click Start->Programs->HighPoint RAID Management Software->
Service Manager to view the service status.

3.  You can access the remote system via TCP/IP connection.
4.  If there is firewall configured on your network, TCP port 7402/7403 should not be

blocked.

Trouble Shooting

5-4



Appendix A
Glossary

Array
Also known as Disk Array-two or more hard disks combined together to appear as a
single device to the host computer.

Broken Array
A disk array with one or more members failed.  Broken RAID 1, 10, or 5 arrays can still
function (by utilizing the remaining disks), but broken RAID 0 or JBOD arrays will no
longer function.

Duplicate
Also known as Synchronize, the operation of duplicating user data to generate backup
data within a RAID 1 array.

Hot Swap
The ability to add or remove a drive without powering off the computer or interrupting
the user’s work.

JBOD
JBOD is an acronym for Just a Bunch of Disks.  It is used to refer to hard disks that aren’t
configured according to RAID a subsystem of disk drives that improves performance
and fault tolerance.  JBOD provides much more capacity (the sum of all the disks).  If
there is more than a single physical disk (not member of an array and not an ATAPI
device or a removable disk), you can create a JBOD array.  The RocketRAID 1810A host
adapter supports two up to four hard disks to create a JBOD array.

Mirroring
Known as RAID 1, which provides data protection by real-time and automatic duplicat-
ing all data from a source disk to a mirror disk.
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PCI-X
The 64-bit PCI-X architecture supports transfer rates above 1 gigabyte per second, and
operates at speeds up to 133 MHz.  In addition, it is backward compatible with existing
standard PCI bus technology.

RAID
Redundant Array of Independent Disks- a method of combining several hard disks
(physical disks) into one logical unit (logical disk), thus providing higher performance
and data redundancy.

RAID Levels
RAID levels refer to different array architectures (or methods of organizing a disk array).
Different RAID levels represent different performance levels, security levels and cost.

RAID 1
Known as RAID 1, this RAID level provides data protection by implementing real-time
and automatic duplication of data from a source disk to a mirror disk.  The RocketRAID
1810A host adapter supports two hard disks to create a RAID 1 array.

RAID 10
It is the combination of RAID 1 and RAID 0.  The RocketRAID 1810A host adapter
supports four hard disks to create a RAID10 array.

RAID 5
RAID 5 includes a rotating parity array, thus, all read and write operations can be
overlapped.  RAID 5 stores parity information but not redundant data.  It requires at
least three disks to provide the most economic way to maximize data capacity with faster
transfer rate.  The RocketRAID 1810A host adapter supports three up to four hard disks
to create a RAID 5 array.

Rebuild
The ability to use a new disk to replace a failed disk in a redundant disk array (RAID 1,
10 and RAID 5 arrays), then repair the broken disk array and recover all the data on that
failed disk.

Striping
Known as RAID 0, data is spread over multiple disks to improve performance.  It does
not provide data protection.  The RocketRAID 1810A host adapter supports two up to
four hard disks to create a RAID 0 array.

Appendix A

A-2



Serial ATA
Serial ATA is an evolutionary replacement for the IDE ATA physical storage interface.
Serial ATA is scalable and will allow future enhancements to the computing platform.

Spare Disk
A free hard disk that can be used to replace the failed member of a redundant disk array,
then automatically recover the redundant disk array without user intervention.

Spare Pool
A collection or grouping of the spare disks.  When a disk is added into the spare pool, it
will become a spare disk.

Synchronize
Same as Duplicate.
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Appendix B
Customer Support

If you encounter any problems or have any questions about the product, please make
sure to read through the manual.

Additional information about HighPoint products is available from our web site:
http://www.highpoint-tech.com

If the information provided by the manual and our web site are unable to answer your
questions or solve the problems, please contact our Customer Support department.
E-mail address:
support@highpoint-tech.com

Thank you for choosing our products!
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FCC Part 15 Class B Radio Frequency Interference Statement
This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to part 15 of the FCC Rules. These limits are designed to provide
reasonable protection against harmful interference in a residential installation. This equip-
ment generates, uses and can radiate radio frequency energy and, if not installed and
used in accordance with the instructions, may cause harmful interference to radio com-
munications. However, there is no guarantee that interference will not occur in a particu-
lar installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, you are en-
couraged to try to correct the interference by one or more of the following measures:

  Reorient or relocate the receiving antenna.
  Increase the separation between the equipment and receiver.
  Connect the equipment into an outlet on a circuit different from that to which the

    receiver is connected.
  Consult the dealer or an experienced radio/TV technician for help.

Modifications not expressly approved by the manufacturer could void the user’s au-
thority to operate the equipment under FCC rules.

This device complies with part 15 of the FCC Rules. Operation is subject to the following
two conditions: (1) this device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may cause undesired
operation.

European Union Compliance Statement
This Information Technologies Equipment has been tested and found to comply
with the following European directives:

  European Standard EN55022 (1998) Class B
  European Standard EN55024 (1998)
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